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POLYGONALmeister is software for editing and evaluating the shape represented 

by the triangle group.

This document explains the operation method for users who are new to 

POLYGONALmeister.

See also the "Quick Guide" on the "Help" tab.

Copyright ©2020 UEL Corporation All Rights Reserved.Copyright ©2021 UEL Corporation All Rights Reserved. 1

For details on how to operate, see the following materials. 

• "Operation Manual (Basic)"

Describes the entire POLYGONALmeister and explains the functions 

and operation methods of each command. 

• "Operation Manual (Utilization)"

Explains the recommended usage for each application.

• "Manual" on the "Help" tab.

Explains the functions and operation methods of 

POLYGONALmeister in detail. 
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Basic Operation of 

POLYGONALmeister

The basic operation method is explained through the following operations:

(1) POLYGONALmeister startup

(2) File import

(3) Cleaning (correction of incorrect parts) 

(4) Simplification (reduction of polygons)

(5) File export and Exit



Copyright ©2021 UEL Corporation All Rights Reserved. 4

(step-1) POLYGONALmeister startup

When POLYGONALmeister is installed, a POLYGONALmeister icon (left in the figure below) will be created 

on the desktop. Double-click this icon to start POLYGONALmeister.

(You can also start from the list of installed applications by pressing the "Start" button.)

The POLYGONALmeister window on the right of the figure below appears.

POLYGONALmeister icon

POLYGONALmeister window

Double click



Register frequently used commands Message from the system

Button to stop processing the command Display progress of processing

Name of imported fileTabs (major classification of commands) Commands

Exiting POLYGONALmeisterPOLYGONALmeister window
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Command selection

Switch "tab" and select "command".

If you move the mouse pointer over the “command" icon, an 

explanation of the command will be displayed.
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Command icon

Explanation

The basic operation flow is as follows.

First, import a mesh(polygon data) from a file, repair any incorrect shape (using the "cleaning" command, 

etc.), and then execute necessary commands. Finally, export  the mesh to a file.

Correct incorrect shape 

Export the mesh to a file

Execute necessary commands

File

Import a mesh from a file File

File format of polygon data imported/exported 

by POLYGONALmeister:

STL, VRML, OBJ, PLY, OFF, 

NAS, BDF, BLK



(3) Select a file to be imported. And click 

“Open” button. 

Reads a polygon data file such as STL.
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(4) When the file importing process is completed, the 

following information is displayed. 

A) Shape of the imported mesh

B) Three-dimensional size of the mesh

C) Number of faces and vertices

D) A symbol that specifies the orientation of the 

coordinate system

(step-2) File Import
(1)

(2)

(3)

(1) Click the "File" tab to display the file 

input/output commands.

(2) Click “Import" to display a File Selection 

Dialogue Box.

One or more external files can also be loaded 

by dropping them from the Explorer onto the 

graphic display area.

A

B
C

D

File Selection Dialogue Box



Mouse operation

Mouse wheel
Rotation:  Enlarge the displayed figure  (PgUp/PgDn can be substituted)

Drag:  Translate the displayed  (Ctrl + drag can be substituted)

Ctrl + rotation:  Move the clip plane  (Ctrl + PgUp/PgDn can be used instead)

Right button
Click:  Change center of enlargement and 

center of rotation

Drag:  Rotate the displayed figure

Left button
Click:  Select command or figure

Drag:  Draw a line

Ctrl + drag:  Translate the displayed

(Some mice do not have wheels, so an alternative operation method is available.)
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You can use the mouse to translate, rotate, and scale the displayed figure on the screen.



Display state setting
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Switches display/non-display of faces.

Switches display/non-display of edges.

□ Edge□ Edge

There are two buttons above and 

down.

If you click the button above (the 

green rectangular parallelepiped is 

drawn), the line of sight changes to 

look from the Z+ direction.

By clicking the button below 

(character part), you can select the 

direction of the line of sight as 

another coordinate axis direction.
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(step-3) Executing the „Cleaning" command

Click "Cleaning" on  "Home" tab

？

The detected errors 

are displayed in red.

“Cleaning” command inspects and repairs error(incorrect) area of the mesh.

A window for selecting the 

inspection item and displaying the 

processing result appears.

Move the cursor over to 

display the explanation of the 

inspection item.

Check all inspection items 

and click "Inspect" button.

The errors are repaired and the number of errors of 

the repaired data is displayed.

Click „Repair" button

The number of detected 

errors is displayed.



Click “Execute" button to start the process. You can see how the number 

of faces gradually decreases.
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(step-4) Executing the „Simplify" command

“Simplify” command reduces the number of faces in the mesh (to keep 

the mesh from deforming as much as possible).

Click “Simplify” command on 

“Home” tab

89,992 faces 8,952 faces



(step-5) File export and Exit

Enter the file name and click "Save" 

button to export the mesh to a file.
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If you click "x" (close) at the top right of the window,

POLYGONALmeister will end.

Click “Execute" button 

Click “Export” 

command on the 

“File” tab
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Registration of POLYGONALmeister 

License

This section describes how to register the POLYGONALmeister license.
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Registration of License

1)  Creating a license application file

Click the line with the fastest link speed among 

the valid lines in the table below, and click the 

"Apply for License File" button.

2)  Send the license application file

Send "License application file" to

pm_license_request@ml.excel.co.jp

as an attachment to an e-mail with the following information in the mail body:

Company name (unnecessary in the case of individuals),  Affiliation (unnecessary in case of individuals),  

Name, Contact (phone number etc.)

We will send "license file" by e-mail normally within 3 to 5 business days.

3) Register the license file in POLYGONALmeister

Click the “Register License" button, select the received license file, and click "Open".

Restart POLYGONALmeister and check that the license is registered in the "License" command table. For 

details on the license registration operation, click the "License Guide" command on the "Help" tab and refer to 

the document that appears.

Click “License” on the “Help” tab. The dialog as 

shown below will be displayed.

A file-save dialog is displayed, and the name 

"PC name _ PC identification information.pmpci" 

is set in the file name. Do not change the file 

name. Save the "license application file" in an 

arbitrary place with the save button.
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Terms Expressing Shapes

This section explains the basic terms used in the forms used in the 

POLYGONALmeister.
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Terms Expressing Shapes

[Mesh] = The whole set of triangles

[Shell] = A collection of connected (sharing edges with adjacent triangles) triangles

[Shell Boundary] = Lines around a shell or lines around a hole in a shell

[Face] = A triangle that composes a mesh

[Edge] = a side of a triangle

[Vertex] = triangle vertex

Shell

Shell boundary

Face

EdgeVertex

Mesh
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Hole

A hole(missing faces) in the surface of 

the mesh, also called a shell boundary. 

A hole that penetrates into a solid. A dent on the mesh surface. 

To fill holes, use the “Fill Holes", 

“Cleaning (holes)", and “Defeature" 

commands. 

Holes in the sheet parts.

Or missing faces that exists because 

the light does not reach in the optical 

measurement. 

Holes for mechanical parts for bolting.

Or holes that exist when the model is 

thin in CT measurement. 

To fill through holes, use the “Fill 

Caves", and “Defeature" commands. 

Dent holes in mechanical parts.

Or dents due to a rough measurement 

surface. 

To fill blind holes, use the “Fill Caves", 

and “Defeature" commands. 

There are three types of mesh holes handled by POLYGONALmeister. 

Hole Through Hole Blind Hole
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POLYGONALmeister ver.5 

Command

The commands of POLYGONALmeister ver.5 are explained for each tab.
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File Tab

Import Export Import Shell

Export Shells Export Faces

Read polygon data from an external file. Export the mesh to an external file.

POLYGONALmeister
FILE

Add the polygon data of the external 

file to the mesh as shells. 

Write the specified shell to an external 

file.

Write the specified faces to an external 

file.

POLYGONALmeister
FILE

POLYGONALmeister
FILE

POLYGONALmeister
FILE

POLYGONALmeister
FILE
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Home Tab

[Vertex] Check in order to display vertices.

[Mesh Comparison] Check in order to divide the figure 

display area into two: mesh before processing or the 

external file on the left; and the current mesh on the right.

[Information] Check in order to display in the figure display 

area face qty, vertex qty and coordinate axes.

[Temporary Figure] Check/uncheck in order to display/hide 

temporary figures such as command execution results. 

[Color]  Check/uncheck in order to enable display/non-

display status of color assigned to faces.

[Face] Check in order to display a face.  

[Edge] Check in order to display an edge.

[Clip] Check in order to hide the figure in front of the 

clipping plane and display the interior of a solid, and thus 

display the internal side of a solid. 

[Initial View]   Click          in order to retrieve the display 

status when the file was imported.  Click        in order to 

enable a display in accordance with the direction of 

selected coordinate axis.

[Clipping plane]   Click            in order to set a plane 

perpendicular to the visual line direction as a clipped 

surface. 

[Ortho] Display method of the figure between parallel projection 

(checked) and single point perspective projection (unchecked) 

can be switched.

[Grid] If checked, a line parallel to the X and Y axes is displayed 

in the XY plane, and a red sphere indicating the origin position 

is displayed.

[Background] You can change the background color of the 

figure display area. Please select from 

gradation/black/white/gray.

[Status bar] Hide the process stop button and the progress 

display area at the bottom of the screen.

[Caption bar] Hides the system message display area.

[Undo] The mesh returns to the state before the previous 

operation was executed (before the command that involves 

changing the shape).

[Redo] Cancel "Undo" to return to the state after execution.

[Result list] Click to display the dialog for managing the saved 

temporary figures.



Approximate the mesh to a smooth 

curved surface and divide the face into 

small pieces so that it fits on the curved 

surface. The mesh will be smooth. 
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Home Tab

Cleaning Defeature Smoothing

Simplify Subdivision Remesh

Inspect and repair incorrect parts of the 

mesh.

Gap between 

shells

Irregular 

Connection

Holes

Folded Faces Small Shells Self-intersection

Remove through holes, blind holes, 

dents, protrusions, self-intersections, etc.

Make smooth by removing fine 

irregularities on the surface of the mesh.

Reduce the number of faces in the mesh 

(to keep the mesh from deforming as 

much as possible). 

Reconstruct the mesh so that the faces 

are close to equilateral triangles.



Copyright ©2021 UEL Corporation All Rights Reserved. 22

Home Tab

Cut Boolean Operation Flip Shells

Delete Shells Scaling Move / Copy

Cut the mesh with a plane. You can 

remove one side of the cut or leave both 

sides.

Create union / difference / intersection 

of two shells.

Flip the front and back sides of the 

specified shells.

Cutting plan

Union

Difference

Intersection

Delete the specified shells. Scale the entire mesh or individual 

shells. You can also change the 

enlargement ratio for each coordinate 

axis direction.

Parallel, rotate, and mirror move the 

entire mesh, shells, and faces. You can 

also make copies and place them. 

Rotate

Copy and transfer
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Home Tab

Drag Move Arrange Shells

Shells can be moved along a straight line 

or on a plane by dragging.

c

b
A

B

C

Arrange shells according to various 

conditions. 

Grab the handle 

and drag 
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Edit  Tab

Primitive Solid Fill Caves Reshape Hole

Make Flat / Cylindrical Through Hole Remove Protrusion

Create a cuboid, cylinder, cone or sphere 

shell.

Detect through holes and blind holes, 

and fill them.

Compensate for the irregularities in a hole 

(through hole, blind hole, and hole in a 

shell) to round.

Original mesh

Detect

Result

The specified area is reshaped into a flat 

or cylindrical surface.

A circular through hole with the specified 

diameter is made at the clicked position.

Detect protrusions of a mesh and 

remove them.

Click

Detect protrusions

Remove

Fill
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Edit  Tab

Projection Solid Difference Solid Transplant

Loop Cut Reshape CT Mesh Reshape Optical Mesh

Sweep the open shell to a flat surface to 

create a solid shell.

Create the difference between the mesh 

and the polygon data of an external file as 

shells.

Embed another shell in the hole.

Cut the mesh with the closed polyline 

drawn on the mesh.

Repair the irregular part of the mesh 

derived from CT measurement, smooth 

the mesh, and remesh the faces to be 

close to equilateral triangles.

Repair the irregular part of the mesh 

derived from optical measurement, 

smooth the mesh, and remesh the faces 

to be close to equilateral triangles.

Irregular connection:

Folded faces:

Self-intersection:

6,081

180

942

0

0

0
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Edit  Tab

Delete Faces Delete Boundary Faces Fill Holes

Extension Align Vertices Flip Edge

Delete the specified faces. Delete faces near the shell boundary. Fill the holes on the mesh surface.

(In order to fill through holes, use the 

"Defeature" or " Fill Caves" command) 

Specify faces 

to delete

Delete 

designated area 

(green faces)

Specify amount 

to delete from 

shell 

boundaries

Delete the 

corresponding 

area (green 

faces)

Extend the mesh smoothly at the shell

boundary.

Adjust the positions of the vertices so 

that the edge strings are connected 

smoothly.

Replace the edge using the 

quadrilateral diagonal formed by two 

triangles on either side of the edge.

Show 

extended 

shape

Extend

quadrilateral diagonal
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Edit  Tab

Merge Vertices Remove Acute Triangles Divide Faces

Move a vertex to its adjacent vertex, and

combine the two vertices into one vertex.

Detects acute triangles and removes 

them.

Move red 

vertex to blue 

vertex, and

combine the 

two vertices 

into one.

Drawn line

Acute-angled triangle

broken

broken

broken

Faces are divided at the intersection of 

their edges and the drawn line.

Edges are 

created at the 

position of the 

drawn line. 
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Evaluation  Tab

Property Distance Coordinates

Circle radius Distance Contour Thickness Inspection

The following features related to the 

shape of the mesh are displayed. 

Measure the distance between the two 

vertices.

The coordinate value of the specified 

vertex is displayed.

- Surface area, Volume

- Center of gravity

- Size(Length of the range where the 

mesh exists in each coordinate axis 

direction)

- Number of shells

- Number of shell boundaries 

- Average / Maximum / Minimum 

edge length

Calculate the radius, diameter, and 

center coordinate values of the circle 

passing through three vertices.

The distance between two figures 

(between shells / before and after 

processing / polygon data in the external 

file and mesh) is painted with a color 

according to the distance for each face. 

The color map of the mesh thickness is 

displayed.
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Evaluation  Tab

Display Section Lines Find Path Crease Detection

Display intersections between the mesh 

and planes.

Display the shortest path (edge ​​string) 

that connects two vertices by following 

an edge.

Detect edges that are bent more than 

the specified angle.

2 vertices

Path

Path length
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Color  Tab

Fill Color Texture Alignment Transfer Color

Convert to Vertex Color Segmentation Edit Segment Boundary

Add colors (texture, face color, vertex 

color) to faces.

Change the area of the texture image 

referenced by the faces.

Change the "texture" or "face color" on 

the mesh to "vertex color".

Divide the mesh into multiple color-

coded areas based on shape feature. 

Merge segments divided by 

"Segmentation" command. 

And smooth a segment boundary.

Face color Vertex color

Enlarge the image

in the frame

Paste the color of the polygon data in the 

external file on the mesh as a texture. 

Modify the shape 

of measurement 

data with other 

commands

Transfer the 

color of the 

original 

polygon data 

Original polygon data 
in external file

Mesh

Mesh
Specify 
painting 

area

Image file

Edit this 
boundary
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3D Print  Tab

Display Forming Table Forming Arrangement Pinned Cut

This function displays the forming table of 

the 3D printer in the figure display area.

Arrange the mesh or shell on the 

forming table with a simple operation.

Cut the mesh, and add protrusions and 

holes to the cut surface.(For assembling 

3D printed objects)

Rotate 90 degrees

Translate so that 

the minimum 

position in the Z 

direction is zero
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Geography  Tab

Terrain Meshing Display Contour Lines Soil / Space Volume

Dekigata Heat Map

Read the Geographic Information 

(GeoTIFF) file and create a mesh that 

reflects the written geographic 

information. 

Display contour lines. Displays the amount of soil volume or 

space volume (volume required to fill the 

soil) in the specified area.

The height difference between the specified 

area and the polygon data of an external file 

is displayed as a heat map. 

GeoTIFF Mesh
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Relief  Tab

Relief Embed Relief Stamp

Create an uneven mesh based on the 

color of the image. 

Add an image to the mesh as an uneven 

pattern. 

Add a pattern to the mesh with the 

characters and handwritten lines to enter.

Embed the letter 

"UEL" as an uneven 

pattern

Image file
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Beta version  Tab

Wrapping Thicken Offset

Fill Region Advanced Self-intersection Removal Sharpen

Create a new mesh using only the 

outside of the mesh.

Add thickness to the shell. Create a mesh that is a fixed distance 

away from the original mesh.

Estimate a surface that passes through 

the peripheral shape of the hole and 

create faces that fills the hole so that it 

rides on the surface.

Correct self-intersections that cannot be 

repaired with the cleaning command.

Makes a rounded ridge area into a 

sharp edge.

Number of self-intersections

= 0

Estimated surface

= 942
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Beta version  Tab

Trim Loop Trim Texture Reconstruction

Trim the mesh with the drawn lines. Divide the mesh by the drawn closed 

line.

Make the texture image adjacency the 

same as the face adjacency.

Trimming lines

Refer

Mesh

Texture image
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Help  Tab

Website License Quick Guide

Manual License Guide

Show the POLYGONALmeister webpage. 

The Japanese web page will be 

displayed, so switch to English with the 

button at the top right of the screen. 

Register the POLYGONALmeister 

license.

Show the minimum information required to 

operate POLYGONALmeister.

Show the operation manual for 

POLYGONALmeister.

Show the POLYGONALmeister license 

guide.


